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This document includes screen prints of Dreamweaver MX software in operation. All Dreamweaver logos, icons and images are protected by copyright registered to Macromedia Inc and are reproduced in this guide under the terms of the licence purchased by Dunstable College.

Views and opinions expressed in this document are those of the author in a personal capacity and may not be attributable to any institution or organisation.

Introduction

These notes will not tell you how to make a web page that flashes or contains text that swoops across the screen. They will not tell you how to make menus that explode when a visitor moves his mouse over them or how to make pop-up windows or a myriad other things that you may think you want. What they will do is give you the basics of good design for the web: how to plan and create pages which will look smart, load quickly and give the impression that you mean business.

The software illustrated is Macromedia’s Dreamweaver MX. This is not cheap and it is not simple to use when you’re starting out but it has become the industry standard and it’s what’s likely to be installed on your PC. 

First thoughts

Before you even start the software, however, you need to plan your site. Whatever you produce will change over time but you need to start somewhere. Wander around the web and get some ideas. See what other people have done. Check out what you feel works and what doesn’t. Think about colours, styles and layout. Then get a clean sheet of paper, a pencil and a rubber and sketch out the initial structure for your place on the net.
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This is a very simple example: there’s a home page – you’ve got to have that – then a contents page with links to various sections or interests. Each section then expands with more information on that particular topic. 

Page names

Give each page a name, a single word is best but if you have to use several, run them together. Try and use some logic when naming pages. portraits1, portraits2 and portraits3, for instance are pretty obviously something to do with the portraits section! The home page has to be called index, whether you like it or not. That’s just the way the web works.

Those names will eventually become index.htm, portrait1.htm etc when they are created and a visitor to your site will arrive at an address something like www.yoursite.com/portraits2.htm which is a lot more sensible than www.yoursite.com/pictures_of_lily.htm where the underscore _ character has to be used to make a space. This may not seem too bad but it can be a real pain for someone trying to type your address in the Explorer address bar and you try typing it! 

Colours and themes

The structure plan may give you some ideas as to colour schemes or themes: for example, you may want all the portrait pages to have one background colour or style and the scenes another. For larger sites with several layers it can be helpful to visitors to have some sort of theme and colour is a good way to achieve this. You will want people to know where they are.
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Layout

The next stage is still in the paper and pencil stage: determining the layout of the main pages. Forget the home and contents type pages for now. Work on the pages for which the same general appearance is desired. You need to allocate areas for the following features: a page title, heading or banner, navigation buttons or bars, images and text. Each page will have some of each – the proportions depending on what you’re doing. Life will be much, much easier if you can create a layout which can be used throughout the main part of your site. The general shape of the page should be similar to a monitor screen. At the time of writing practically all screens have a landscape format of about 3:2. A widescreen format is starting to appear as well as flat panels which rotate to display portrait, more vertical pages. For now, though, stick to the 3:2 ratio. Basically, you want to avoid people having to scroll up and down or, particularly, left and right, just to see your page properly. You want it to appear, right there, on their screens without scroll bars. There will be exceptions to this which I shall come back to later but, unless your whole site comprises lengthy text documents or galleries of pictures, try and stay within the shape you’ve got.

If the whole page arrives on the screen at once then you have more freedom in positioning the titles and navigation features. The traditional places are at the top and left edges because these will always be in view for all but the tiniest of browser windows. Current design trends, however, are moving right and down so the choice is yours.

Here’s an example of a page layout sketch. It needn’t be terribly accurate but this is where you should make some notes about ideas for colours, fonts and buttons. You’ll need to consider how any images will sit on the page too – if you have something in mind already, this might influence the colours for the rest of the page.
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Bright pink text on a vivid green background may catch people’s eye but save such wild extreme design concepts until you really know what you’re doing! It’s not ‘wrong’ but it’s likely to turn most visitors off. Shades of a single colour can be very effective, with the lightest as a background and the darkest for text (or vice versa). Black, greys and white can work but can be dull if you’re not careful. Avoid any combination of green and red – not just because the colour blind will see them as the same colour – they really can drive viewers wild.

You may wish to use a texture, or shaded feature or background. It’s difficult to know how this will turn out until you start working on the real page but you may have spotted something on the web that works well and should note it on the sketch rather than trying to reproduce it. Images as backgrounds seldom work – in fact they practically never work because everyone’s browser window is a different size and unless you have a huge image (which brings its own problems) your lovely picture will start repeating itself on people’s screens and look nothing like you’d expected or desired! Textures, shades, gradients OK. Images no.

Keep the text area no more than about half the width of the screen. Newspapers have columns and books are the shape they are because people really don’t enjoy reading long long lines of text. That’s just the way it is. It’s actually preferable to have the text either a little smaller or to have to scroll down longer sections than to have those wide stretches of long text lines. Break up text too. In your sketch, of course, there’s no need to enter the text itself but an indication of the line length and rough font size is a good idea. Headings can be useful – indicate any you’re thinking about using as they’ll need a different size or style of text.

The earlier illustrations showed samples of layouts for a page with a lot of text, a page with mostly images and some of each – all retaining the same overall theme or design style.

Do sketches for each of your main pages.

The main elements

By now you’ll have a pretty good idea of what material you need to collect for the pages. As mentioned before this comprises text, images, design elements or graphics, banners or headings and navigation buttons.

We’ll take them in that order.

Text

Text you may be able to type as you go, inventing it as you type. Alternatively, you may have some text already prepared, like a poem or a review of a product. Most people make it up as they do the page. It’s up to you, but if you have some particular text to copy make sure you know where to find it.

Images

If you need to take your own photographs or scan images do it now and make a note of where the originals are stored. If you’re using images from the net or from other sites (more about copyright later) make a note of what you need and where, if you know, they are. Most sites have a lot of images and you’ll need a list of them.

Design elements and graphics

As for images, some may have to be created from scratch and others you can obtain elsewhere. Include these in your list.

Banners or headings

You can leave these for now. Just know what you want them to say.

Navigation buttons

Leave these for now. All you need is a note of the button text and the page it links to.

Layout tables

Take another look at your page layout sketches. You will need to figure out a way of positioning the various elements on the page. The best method is to use a table, or grid. The illustration below demonstrates how a simple 7 x 5 grid can contain everything and a table has the advantage of making the alignment of elements much simpler.
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If you are familiar with tables in Word then this aspect of creating your pages will be pretty straightforward and you may be able to work out where to put things as you create the page. If tables are new to you then it is well worth experimenting with sketches as you will need to set up the required number of rows and columns at a very early stage when you start using the software.

That should complete the initial planning stage. I’m assuming that you have some idea of what the site is for, who it’s intended to appeal to and have enough material to fill several pages! The days of a one-page ‘About Me’ site are long gone.

Site folder

Your web site will in reality be a collection of files, stored in a folder on a computer somewhere – wherever who controls access to your site locates it. This server needs to be continuously running and connected to the internet so that people can see your site at any time of day, from anywhere on the planet. When you publish your site you effectively just copy your files to that folder. It is therefore of fundamental importance that you create a folder on your PC where absolutely every file to be published will need to be stored.

So set up a folder with a sensible name. At the same time it’s a good idea to set up another folder with a similar name + drafts (or whatever) where you can collect files and store work in progress. You will inevitably gather more files than you actually publish and, certainly in the case of images or graphics, you will be making adjustments prior to publishing. For example, web images are generally of quite low quality and much smaller than the original photograph or drawing. You’ll wish to keep the original files but only publish the smaller, adjusted version. So just the web version will be in the site publishing folder, the others staying in your web drafts folder.

Whilst you can have subfolders within the publishing folder they need to be treated with care because they will form part of the url or address of the pages they contain. For example, if you have a subfolder called pictures containing the page lily.htm its address will be www.yoursite.com/pictures/lily.htm. Now, that looks quite sensible but if your folder had been called pictures small 2 the address would appear as something like www.yoursite.com/pictures%20small%202/lily.htm which isn’t! Making links and navigation can also be upset, especially if you later more files from one folder to another. For a modest-sized site you can get away easily with a single folder and several complications will simply not arise. (The software you use to create the pages will probably create some folders anyway.)

Links to other sites

The last bit of preparation is to list any links to other web sites that you may wish to use. The simplest way is just to go to the site and copy the url that appears in the Explorer address bar. You will find that many sites have ridiculously long and tortuous page addresses and you will not wish to attempt retyping them. Paste the url in a Word, or similar, file for the time being. You can then copy it from there and paste it into your web page later and the hyperlink will be retained. You can also check that the links work before including it in a page – there’s nothing more annoying for visitors than links that don’t work!

Starting in Dreamweaver

Now it’s time to start the real design work. Start Dreamweaver MX. 
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Define the site (don’t ask, just do it . . .)

Tempting as it might be to start designing, the people at Macromedia didn’t think like that when they designed Dreamweaver. Even in its latest form MX 2004, you need to do some admin! You have to enter the basic information about your site. Do this using the Site menu>New Site.
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There is a choice of basic and advanced routes through site definition. Here the advanced route is illustrated – if you choose the basic the entries will be similar. First, Local Info requires a Site Name. Use something sensible, although it will not appear on any published pages so it’s not terribly important. Use the yellow folder to browse for your site folder, open it, select it and its address will be entered as the Local Root Folder. (If you didn’t create one, you can now do so using the New Folder icon in the Windows browser window).

Leave a tick in Refresh Local File List Automatically. 

Unless you have one, ignore the default images folder entry.

If you know the address for your site you can enter it now. Otherwise it can be left until later. Leave a tick in the Cache box.

Click on the Remote Info tab.
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For now, leave the Access at None unless you are confident that you have the correct entries required for the type of connection that will apply. (These notes cannot cover this aspect for every type but the most common, FTP, will be dealt with in other notes.)

You can safely ignore Testing Server, Cloaking and Design Notes for now, if not forever, and the last tab you need is Site Map Layout.
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Dreamweaver needs to know the location and name of your home page. You haven’t, of course, got one yet so just type index.htm in the box. Leave the other items as they are. Trying to get out of this window will bring up this message:
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Helpfully telling you what you already know; take up their offer with OK.

If the OK button at the foot of the Advanced window is available click that next. If it is unavailable click on the Basic tab and the Done button should be available to allow you to get on with some work.
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You will now be returned to the main window. On the right a panel will display your site files (only index.htm at present) if the MX default settings apply. If there are no panels visible press F4 and they should appear. You’ll need the Insert panel to display some useful icons in a toolbar along the top and the Properties panel below the page area. If you have trouble accessing them try Windows>Insert and >Properties. (Another odd couple of instructions. You’ll soon gather that Dreamweaver menus never seem to contain what you’d expect and the things you need quite often can be buried in sub menus whilst highly advanced tools lurk at your elbow. Oh well.)

Templates (well, sort of . . .)

The open page will be called Untitled-1 (or another number if you’ve been messing around already). Your next task is to try to create one of the page layouts you sketched earlier. There are two approaches to this. You could create that particular page with its own pictures, text and buttons and save it as, say, portraits.htm. Then save it again as, say, scenes.htm and change those bits which will be different and leave alone the bits that shouldn’t change.

The other way is to create the page structure and just those bits which don’t change, like a template, and save it as something like sample.htm. You then fill in the portrait bits and save it as portrait.htm. Open sample.htm again and enter the scenes bits and save that as scenes.htm. This is probably the smartest method, as long as you keep sample.htm unsullied, but it does require more thought, working out which bits change and which bits don’t.

Dreamweaver does have a proper template facility but that is even more complicated and really isn’t necessary for a smallish site. I may do some notes about this facility for more advanced sessions or the experts out there can delve into them on their own. In my view, though, they’re not worth the effort for beginners or anyone with less than a dozen or so pages to do.

In these notes I describe the sample.htm method – creating a sort of template which can then be used for most of the other pages.

My ‘fixed’ elements are: a site title which appears on every page with a logo, the navigation buttons, some copyright text and a date at the foot of the page and the background colour and the text and illustration areas and shades. For simplicity I shall also use the same page title throughout the site.

Create the table first, (colours later)

For my purposes a table 7 columns wide and 5 rows deep will be ideal. I shall also use a pale textured background for the whole page. Tempting as it might be to start on the colours, it is usually sensible to do the table first. This is because the guidelines for the grid are thin dotted lines which may not be very clear against some background shades. The Insert toolbar illustrated below has 12 tabs. You’ll probably only need the first, Common, which should already be to the fore. (Click on Common if it isn’t.)
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Immediately below the Common tab is the Table icon. Click on it.

[image: image13.jpg]e 1ttt § =

G [+t ¢ o)
e ] G





Enter the number of rows and columns you need. Cell padding is the space within cell borders between the edge of the cell and whatever you put in it. Padding is useful and helps avoid adjacent cell contents bumping into each other. Cell spacing is the gap between cells and has a similar effect. Once you have some contents you may wish to experiment with different settings to appreciate the difference and decide which works best for your page. Measurements are in pixels. 

Pixels (a brief departure – but you do need to know . . .)

Pixels are the standard unit of design measurement, and can be thought of as dots. You’ll need to understand the way they work. A typical monitor may be set to display 800 pixels across and 600 pixels down. If you had some images that were 100 pixels by 100 pixels square then you could, in theory, place 8 across the screen and 6 down. (In practice things like scroll bars, menus, taskbars and the like tend to reduce the visible area somewhat but you get the idea.)

Displays can go to higher settings: 1600x1200 being more frequently encountered these days, for example, and many laptops are best at 1024x768. Web pages will be viewed on a whole range of monitors, however, including some ancient ones at 600x480. The best option seems to be to design for the 800x600 market unless you have very good reason to go smaller or larger.

You will gather that it doesn’t matter how big a monitor is. A 21” screen set at a low resolution may show less of your page than a 15” panel at a high one. The relationship between resolution and size depends on the number of dots per inch – dpi – used in the image design. A 100 pixel square image will look about 1” square – images are displayed at between 70 and about 100 on monitors. 

Cell padding and spacing will normally be in single figures and this will produce the fraction of an inch gap needed.

Back to the table (enough about pixels . . .)

Width refers to the whole table. If, as in this case, the table is to be the framework for the whole page then you’ll want the table to more or less fill the browser window when it’s viewed. Whilst you can enter a number of pixels here it is usually best to use a percentage. Then the table width will adjust itself to the browser window. Something a little less than 100% is recommended and here it has been set to 95%.

The last entry refers to Cell borders. I have yet to see borders that look even vaguely attractive. Set them to 0 which means you won’t get any. There are better ways to do borders if you must have some. The default setting for Dreamweaver used to be 1 for borders and people regularly forgot to change it and despaired at ugly, boxy pages – particularly as it was not at all clear how to get rid of them. I think you’ll find the default in MX is 0. 

Press OK and this is what you’ll get for your efforts:
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Hardly stunning, but you’re on your way. Now you need to pick out which boxes will be used for what. In this site I want some 150 square cells for pictures. You can change several adjacent cells at once to the same settings. To change a single cell, just click in it. To change several select them by dragging across them and an outline will appear. Sizing and alignment are dealt with in the Properties section at the foot of the screen.
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The default setting is left aligned and vertically centred, another of Dreamweaver’s annoying features as it is seldom what you want. I need the images to be displayed in the centre of each of the cells so Horiz and Vert settings have been changed as shown. The images are 120x120 so choosing 150x150 will produce a border effect and ensure even spacing. You may not know the size of your images at this stage in which case just leave the dimensions blank for now and change them later. Dreamweaver will do its best to allocate space in the meantime.

Merging cells (making space for things . . .)
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You will also need to merge some cells together to provide larger areas for bigger pictures, text or a navigation feature etc. To do this select the cells to merge and click on the merge cells icon in the Properties window. (It’s greyed out in the illustration above because that picture was taken with only a single cell selected – hence only the split cells icon is available there.)

If you have trouble with the dimensions you may find it helpful to display a ruler along the top and left side of the page. To get this use the View>Rulers>Show menu option.
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You can drag table lines around to get a visual display right but the settings will not remain that way unless you actually specify dimensions in the Properties dialogue. Instead of pixels you can use percentages if you prefer.

Remember that all the dimensions will have to add up to the right figure at the end of the day and Dreamweaver will refuse to accept settings which simply don’t make sense! Sometimes it can be useful to leave one column unspecified which Dreamweaver can use as free space for whatever is left after deducting your specified sizes from whatever the overall width is. I tend not to specify vertical dimensions (other than certain individual cells) and leave Dreamweaver to sort them out for me, working generally by how it looks as I go.
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Now you should have a display that is beginning to make some sense. The illustration above sort of matches the initial sketches illustrated at the design stage earlier. Hopefully yours will too.

Save the sample layout page

The next step is to save the page. Call it something like sample1 (it doesn’t matter too much as it won’t be a visible part of your site but avoid calling it template). Dreamweaver should offer the correct folder straightaway (but check!) and will add the .htm suffix. The tab will be renamed and the new page will be added to the file list on the right. (If you don’t save now then you’ll be bothered by annoying messages saying that you haven’t saved it during the next stages. It’s your choice.)

You may notice that the File>Save as menu offers a template option. Don’t use that if you want to follow these notes. (It is a good idea – later - for the more proficient amongst you but read the help files before going down that route).

Page properties

Time to start really making the page. Unless you want a white background and black text throughout use Modify>Page properties to bring up this window:
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Title

This is very important, but often missed. It can be entered in the box on the toolbar but you may as well put in now. Whatever you enter here will be what is displayed at the top of the browser window. (Usually prefaced by Microsoft Internet Explorer or whatever). People see this. It tells them where they are. It’s like the plate on your car or the street sign in your road. It has to be right. It’s also one of the main sources of data for search engines so if you want to be found when someone puts splurge into a search engine include the word splurge in your page title.

In some sites every page has a different name; in others they’re all the same. The latter is the easiest and avoids your having to think too much. Whichever you choose put something in otherwise you’ll be billed as Untitled-1 and look dumb.

Background

You can either choose an image (preferably a texture which will tile continuously rather than a defined shape which childishly repeats itself across the page) or a colour. You can’t choose both here. If you want a general background for the page and another for table area then set the first here and we’ll come to the table properties later.

You choose colours from a palette. It is advisable to pick one from the grid as these will be reasonably accurately displayed on another person’s screen. If you need to match a particular colour from the page the colour picker, attached to the mouse icon, is an easy way to do so.

Colours will load faster than background images. If you use an image you will need to browse to locate it and then accept Dreamweaver’s offer to copy it to your folder. Do make sure that it is a small image (file size) – 5kb should be the absolute maximum and that it does tile properly. If in doubt choose a plain colour for now.

Text colour

The only other thing to choose is text colour. The technique is the same as for background colours. This choice will be the default colour for your page. It can be changed for particular sections of text in the Properties panel. The default colour is black so if you have used black or a dark colour for the background it may need to be a light colour to be visible.

Visited Links, Active Links and Links should be left at their default colours. These are the colours that hyperlink text will change to when your page is viewed in your browser: blue for a normal link, purple for visited and active links. There are two reasons for leaving them alone. The first is that you probably won’t want to use text links much, if at all, and the second is that even if you change the colours, many browsers will still display the international default colours anyway! People generally know now that blue, underlined text is a hyperlink and that the purple versions are places they’ve already been to. Now, the wackier readers may well decide that that is reason enough to confuse everyone and bring on the pinks and greens but they’re likely to be the types who wouldn’t been seen dead using text links in the first place. There is a point to note here, though: use blue or purple backgrounds for text with care – text links may easily become invisible against these colours!

Tracing Image (you don’t need one)

There’s nothing else you need in this window but as Tracing Image will intrigue you I’d better explain what it is. This is a facility for placing an image behind your page. It is a design tool only: it doesn’t show in the browser. Its use is for those who may wish to place page design elements accurately – perhaps various points will be set out along a curve and it would be helpful to have that curve to work with. That’s all. Not as exciting as it sounds, I’m afraid.

OK your way out of Page Properties and you should see the result – just a change of background, probably.

Formatting page layout areas

In the example I’m using I want the image squares to have a dark background and to have a dark strip at the top, side and bottom of the table. I shall also need a large, coloured font at the top. To do this, use the Properties panel.
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Fonts (oh dear . . . you’re going to be disappointed . . .)

In the Font settings boxes you will find just a few choices: Times New Roman, Courier, Arial, Verdana, Georgia and Wingdings are the usual options. These are some of the very few fonts that are truly international. Some may use the word ubiquitous and it is indeed remarkable that in the 21st Century there are no more available than was the case in the early 90s. As it stands today, if your font is not installed on a viewer’s PC then a substitute will be used, often with disastrous results (which you’ll never see). So, only use fonts which you are sure others will have. Most UK viewers will have the standard set that came with Windows95 so you may get away with some of them but be careful. 

The Size options are not what you’ll be used to from Word either. There are just 7 sizes available: 1 is tiny, 7 is biggish. Most normal text you see is size 2 or 3. 1 is just for footnotes, copyright phrases and the like. Trial and error is as good a method as any for choosing sizes. When you eventually preview a page you’ll see what it looks like – and don’t forget to check the browser text size settings. There are five. The middle one is Medium which is how most people’s systems are set but it’s worth seeing what your page looks like at the Smaller and Larger settings as occasionally you’ll find text which appears to fit nicely gets unexpectedly split at the Larger setting.

Text colours work in the same way as other colours. Select the cell(s) and apply the colour at the same time as the size and style. The Properties panel may still register default if you have no actual text selected but this should change when you click in a single cell and type something.

The default colour you set in Page Properties will still apply to areas you leave unchanged.

You can also select bold, italic, bullets and the like in a similar manner to Word – all best applied after you’ve entered some text (which will come later).

The Bg boxes allow individual or groups of cells to be coloured or given a background image or texture.

Remember that you’re still just creating a template page so only add what is likely to be featured on each of the main web site pages. In this example I am producing pages with images in various categories so the heading is only partially complete. I have included a motif in the top left cell and copyright and update notes in the bottom row.

Preview (Objects in the preview window are not quite as they seem)

The illustrations below show both the Dreamweaver page view and the first Preview in an Explorer window. This is worth doing often as you progress as the Preview can sometimes be quite different! Press the F12 key for previews.
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A few extra bits

There are some features in the example worth explaining. The © symbol can be found by clicking on the Characters tab. The update entry is a useful guide both for visitors (few sites last updated in 1998 will be worth lingering on) and yourself as your site grows and some areas need refreshing.

To enter a date use the Date icon and this window appears:
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You won’t need a Day Format. Choose a Date Format and a time if you wish and tick the Update Automatically On Save box. Every time you amend a page in Dreamweaver the date will change. (Of course, you still have to remember to publish it!) 

Images

To insert an image click in the cell where it is to go and use the Image button on the toolbar. Locate your image and Dreamweaver will copy it to your folder. You may need to align the image within the cell. Click in the cell, not on the image, and that will allow access to the Cell Properties panel.

Beware of big images!! Even huge files will simply fly onto your page on your own PC but they’ll take ages on the poor old visitors with their dial-up connections. Do check your image file sizes. Before you bring them in. Whilst you may have access to Fireworks for image editing the simplest solution is to adjust your image in a program like Adobe PhotoShop, Serif PhotoPlus, PaintShop Pro or you’ll find the totally free IrfanView 3.80 excellent. This topic is dealt with in separate notes but, generally, reduce the dimensions of the image to about the size you need. It can be adjusted within Dreamweaver but that is pretty pointless because that won’t reduce the file size. Avoid bitmaps (files that end .bmp) or, indeed, anything that doesn’t end in either .jpg (for photos) or .gif (for graphics).  The size and type of image can be changed in the software mentioned and you can achieve huge reductions in file size with virtually no noticeable drop in quality for web display.

If you have to have large images you can still keep under 40kb with reasonable quality. Even that will take about 10 seconds to appear on the average dial-up (no-one actually gets 56k) – just count to ten slowly and you’ll appreciate that that is about the limit of visitors’ patience!

Sites which are galleries of artwork and have to display top quality and large pictures are the exception to the rule but you’ll find that they place those pictures on separate pages and use thumbnails on the main pages.

Navigation

People will want to get round your site easily. Most like to click buttons but you can use images which display information when the mouse goes over them or even rollover images which change on mouseover. There’s also the text option and a Flash text option.

We’ll look at each in turn as they all have their merits. Before you start, though, you’ll need to have a list of all the page filenames you wish to link to. It’s well worth writing them down (you’ll need them again later) and it is strongly recommended that you stick to lower case letters (no capitals), avoid spaces and end all of them .htm with no dot after .htm!

Buttons

Buttons can be made if you know your way around image design software. This will be touched on below but is a bit outside the scope of these notes. The simple solution is to use the buttons which come with Dreamweaver. Click where the first button is to be inserted. You’ll find them via Insert>Interactive Images>Flash Button.
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Select a style and enter the appropriate Button Text. Use the same Font and Size for all the buttons that will be appearing together. The Link will be to the correct page filename as referred to earlier. Type it in, including the .htm bit. You may have to change the Background colour of the button to match the colour of the section where it is to be placed. Let Dreamweaver call it whatever it wants and press OK. The first button should appear.

If the buttons are to be arranged vertically you can separate them either with a Return or, if that is too great, try Shift+Return. Then do the next buttons.
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Using images as links

The next option is to use a picture, or graphic element as a link. Insert your image and/or select it. The Image Properties panel appears.
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In the Link box type the name of the page to be accessed by clicking your image. If it is a page outside your own site you should enter the full url (address). The mouseover text is called Alt text (from the days when some browsers did not show images and we all had to put some alternative text in for their benefit). Just type in whatever you want to say. You can also choose whether clicking the link opens a new window or just moves them on like normal links. The new window option is quite a good idea if you are linking to other web sites or where you just want to illustrate something without giving visitors all the bother of having to go back back back to where they were. The _blank option in the Target window achieves this nicely.

Rollover Images 

Rollover images are very popular and quite easy to do. You need to prepare two images which are identical in size. One will be the image that loads with the page. The second will be the image that appears when the mouse runs over it. This looks best when the images are similar – such as photos at different contrast settings, identical graphics in different shades etc. Quite different images can produce odd effects – but occasionally these can be good.

Use the Rollover Image button on the toolbar.
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The entries are very straightforward. Let Dreamweaver name the image in the first box, browse for your two images and leave the tick in the Preload box. Enter your link text and the url or file name. Press OK and preview (F12) to check how it looks.
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Text links

You can make very simple links by just typing the words, selecting them and entering the required link in the Properties panel. You will have to put up with underlined links and, probably, the blue/purple hyperlink colour scheme and, of course, the rather limited choice of fonts. I have seen this technique work well – the BBC use it a lot and many of the once very flashy sites have recently reverted to this lighter style for pages otherwise crammed with images and other graphics. It’s easy and it may be a good first navigation scheme if you’re unsure about the other methods at this stage (or simply want something flashy but haven’t yet done the designs).

There is another solution – Flash text which is quite smart. Access it through Insert>Interactive Images>Flash Text
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This allows any font to be used, which is nice. Size will be a matter of guesswork and you can experiment with different colours for the first load and rollover settings. Tick Show Font and enter the Link and choose the Target as discussed earlier. You don’t get an Alt option. The only problem is with the background. It really only works well on plain colours. If you have a textured background then you’ll get a rectangle that is quite obviously different. If you’re going to use Flash Text you may need to adjust the design elements behind it.
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There are plenty of other navigation options, including a complete bar option in Dreamweaver and some smart expanding script menus in Flash and Fireworks. These can be hard work, though, and are not for beginners. You may be better off looking at some of the freeware that is available now specifically designed to make elements of web design easy rather than battling with the coding yourself.

Remember that all that most visitors will want is to get around easily and clear, simple buttons take some beating.

If you need to change any of the Flash or Rollover items either double click on them or use the Edit button which is available in their Properties panel when an item is selected.

A note about Flash

Flash elements do require that visitors have a reasonably recent version of Macromedia Flash software installed on their PC. Once that was sufficiently uncertain to warrant recommendations against its use but now it appears to be sufficiently well-established across the world and I tend not to think twice about it. If you are concerned that visitors may not be able to get around your site, or see important elements, then you should produce a parallel set of pages using non-Flash elements and divert people to that site. Your home page should certainly not feature Flash (more on that later) and it may be sensible to have a contents or site map page which provides clear links to the alternative site. Unless your visitors are predominantly familiar with things like this, do avoid the invitations to download software just so that they can see your pages – it just turns people off these days and they’ll move off somewhere else and never get your or your client’s message.

The sample layout’s complete – save it*

That completes the design stage of your sample, or template, page. Save it. Ctrl+S is the quickest way. Dreamweaver places an asterisk against the file name on the tab and in the Window title bar until pages are saved.

Creating the actual site pages

Now you can add the particular items you want for each of the real pages in turn. Do one and save it with the name used for the navigation link or button. Open the sample again and add different bits for another page. Save that with another link name . . . and so on. Check that your links do work. A space or odd character here and there will lead to a broken link.

The Home page

You’ll have links to it and there’s a blank one in the folder that Dreamweaver created when you started out. Now it’s time to make it. However tempted you may be to do the Home page first I cannot emphasise too strongly the sense in leaving it till later, if not last! You will have acquired quite a few useful skills by now and will also have some clearer ideas of what works and what doesn’t on the web. You should also have accumulated a bundle of images and designs and will know just what your site is all about and what it contains, or will contain. 

Your Home page, index.htm, is where people arrive when they type your web address in to the browser. If they don’t like what they see they’ll just go away. If it takes ages to appear on their screen they’ll go away. There are, broadly, two main types of Home page: the minimalist title, image and merest hint of what’s inside and the newspaper style information powerhouse that more or less the whole site encapsulated in one page of mostly text and small graphics.

Either can be fine, just as can a myriad variations on either theme. My suggestion is to go for the basic Home page which links directly to a more informational Contents page (or site index, map or whatever).

Neither of these pages needs the template you’ve been using. It can be used but these tend to have forms of their own. What you do need is to retain some of the design themes – be it a colour scheme or graphic style or just a logo or motif so that there is some continuity and recognition, especially when they return, as one hopes they will do, and arrive at your home page and it’s familiar territory to them.

A Home page of the minimalist variety must not scroll, under any circumstances (barring a squished-up browser window). The newsy type may, but only vertically. So, if you’re only featuring three elements: an image, a title and a link, they need to be good. Find an image which is good quality and sort of sums up what your site, or part of it, at least, is all about. This can be difficult and you may need to get help from others and trawl through image sites on the net. Your tutor should have some ideas or check out the links in the Studyzone or contact me for help if you’re really stuck.

Size-wise, go for something between 200 and 400 wide and 150 and 300 deep. That should ensure the page’ll fit any old browser OK. It’s also big enough to provide some decent quality without dramatic file size. Use the optimisation features of an image editor if you can – Serif’s is particularly good – to see how low you can go with .jpgs before the pixels get painfully obvious. For a graphic or logo you’ll probably be in .gif mode and may be able to cut the number of colours used without significant loss of quality. Beware transparent .gifs with curved edges, especially circles. No matter how hard you try you’ll still find annoying little dots showing through at the edges against dark backgrounds. 

Once you have your images select a background which complements them, rather than the other way round. Go for either a major contrast or an exact match. Half-way houses are risky. Shadows behind images can be effective if you can do them in your software but invariably only work well on light backgrounds.

The text can be the trickiest bit, strangely. You now know the limitations of font styles and size so you only have colour to work with if you stick with simply typed-in stuff. That is unlikely to be good enough (although it can work sometimes). Large size 6 or 7 text can vary wildly if someone has the larger or largest text size setting on their browser. What occupied a single line nicely at the design stage and in your browser may erupt into a couple of awkward-looking lines and shove everything else around the page.

A solution is to make your text an image. Then you can use any font you like, a brilliant array of colour, texture, or even image fills and shadows, bevels to your heart’s content, with care, however, about the background again. 

Sample text graphics
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Arranging your chosen elements on the page is probably more important when there are so few and you’ll just have to try them in various positions until something just grabs you. If all else fails, a straight centre spread will (nearly) always work as will a right column of stuff in many cases where the items are of about the same width.

As with the other pages, a table is a very useful aid – if you need central alignment use an odd number of rows and columns so that there’s always a middle one.

Sample pages

On the next page are examples of a simple home page and a newsletter-style contents page. There is some debate about whether you should help visitors by the inclusion of Enter or similar. On balance I guess you should give them a reasonable clue as to how to get in or they may just think that’s all there is. My own sites, however, don’t usually have an obvious entry point – I use image Alt text in the hope that people will wander around a bit with the mouse before leaving. In the home page illustrated each picture and the graphic text all link to the Contents page (with different text).

The home page illustrates the use of blank space well and the right column of images closes off the page whereas a left set leaves the eye no place to go as it naturally tends to wander right.

The contents page is very full but the use of columns and a few illustrations (graphics would have been better) breaks it up and it all fits well. On the right is a full menu, using the old-fashioned text links. They look OK and the page is virtually the same total file size – 30kb – as the Home page. They’re both heavier than I’d like but with a little more effort (these have only been produced to illustrate these notes) I could get them down to about 20kb which should load in 2 or 3 seconds.
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That’s all folks!

You should now be able to use the basic tools of sound design and have sufficient knowledge of Dreamweaver to make a reasonable go of creating a site.

I shall provide separate notes on publishing – the method varies depending upon where the site is to be hosted – and there are also notes available on several other aspects of design and desk top publishing.

Visit the Studyzone at http://ahi2000.com/studyzone for more information and updates.

Good luck!
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